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Introduction

You may skip section 1- Introduction and directly move to section 2- Before
you Proceed. However, we recommend reading through the introduction to
familiarize yourself with the features and functions of BizFAX and help
improve its operation. Thank you for purchasing BizFAX!

1.1 Product Introduction

BizFAX — Paperless Fax Server

BizFAX paperless fax system is an intelligent fax server that combines the
traditional fax technology and network technology.

After connected the PSTN telephone line and built up the connetion with the
LAN or internet, by using the BizFAX Client software on their computers,
users can easily to create a safe, efficient and affordable fax system for
enterprise.

Through BizFAX Client software or BizFAX Web Client, every user is able to
get the auto-receive, auto-fax and management features. When sending a
fax, users only need to submit file to BizFAX server, and then system will
auto fax the files in order.

Administrator has the authority to configure the system parameters and
manage the users’ information.

1.2 Functions

1. Auto Receive & Send Fax

To receive and send faxes automatically on computer that dispense with
additional fax machine, BizFAX delivers a significant reduction in document
delivery costs by eliminating the need for paper-based print, stand-alone fax
machines and associated maintaenance, supply and labor costs. All the
operations of traditional fax like print, dial, fax, re-dail when busy, postpone
delivery or send in groups can be easily done within few seconds.

2. Electronic Signature
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BizFAX system help users to make their own signature and company stamp
on a electronic document directly. All the signatures and stamps are safely
protected and managed through high-end cryptography technology.

3. Remote Receive & Send Fax
Users are allowed to check and send faxes remotely by using BizFAX Client
software at any time any places as long as they can access into internet.

4. Intelligent Voice Operating System
When receiving a fax, BizFAX will auto play the voice prompts. User can
customize the voice files according to their own demands.

5. System Shareable

Users will be glad to get rid of an uninteresting task that must run around in
order to make a fax. They can send or receive a fax on any of the computers
in LAN. Moreover, BizFAX will auto send a document to corresponding
extension after received a fax.

6. Multiple-Line Support
If there is quantity of documents waiting to receive or send, system will find
an idle line automatically and balance the load among lines.

7. Auto converting format
BizFAX can auto convert documents in any format (word, excel, pdf, jpg and
gif) to required TIFF format before sending out.

8. Listing of task
All of the submitted fax tasks will form a fax queue automatically before
sending out by BizFAX.

9. Send Group Faxes
Simple organize the different users to a group for sending faxes to they at
the same time. All the success and failure fax information are recorded on
history for reference.

10. Retry of failed fax

We will try the best to ensure each fax can be sent successfully to the
destination in time. When the other party is busy, unanswered or something
else that result in the failure, system will auto resend fax. Here user can set
the time (when) and number of retry times.

11. Auto Distributing
BizFAX can auto distribute the received faxes to corresponding users by
user’s extension number. If system is uncertain of the receiver, fax
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administrator will get the faxes and mange them together.

12. Internally Transferring
It supports the free fax and document transfer internally among all virtual
fax extension users.

13. FAX Notifier

BizFAX will send a notifier to sender whether it successfully finishes the fax
task or not. Either of the computers in LAN receives a fax, system auto will
notify users in time to view and back up all the received and sent faxes.

14. Fax to E-mail

When system is auto distributing the received faxes, and meanwhile it is
sending faxes to a pre-set Email address once users enable the Fax to Email
function.

15. Caller ID
BizFAX support the international FSK CID format and recognize the fax
source correctly for block spam faxes directly.

1.2 Hardware Specification

1.2.1 Exterior Appearance

1) Front Side
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O 2@ 6 ©66o®

Figure 1-1 BizFAX Front Panel Picture

No. Identifying

@ Green Light: Indicates the power connection is normal.

@ Green Light blink: Indicates the server system is in working.
® Green Light: Indicates the system is ready.

@ Green Light blink: Indicates the internet interface in use

® Green Light: Indicates the PSTN lines connect successfully.
©® Green Light blink: Indicates the PSTN line in use.

@ Green Light: Indicates the port is work well.

Green Light blink: Indicates the FAX machine in use.

2) Back Side

> VA =TH9

Figure 1-2 MyPBX Back Side Picture
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1.3 Package Contents

1 unit of BizFAX server

1 power supply

1 Internet line

Few telephone cables [RJ-11]

> > > >

Note: If any of the above items is damaged or missing, contact your reseller.
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System set up 2

2.1 Connection Drawing

1 FXS|Lines LAN

“ ]

FAX Machine

Virtual FAX Extension
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2.2 Connecting Ethernet Line

BizFAX provides two 10/100M Ethernet ports with RJ45 interface and LED.
Besides transporting voice, Ethernet port can also send information of
managing, maintaining and operating.

Plug Ethernet line into BizFAX’s Ethernet port, and then connect the other
head of Ethernet line with hub, switch, router, LAN or WAN. Check the status
of LED after connection, yellow light indicates port is in connecting process,
green light indicates the port is in working.

2.3 Connecting Power

BizFAX utilizes the high-performance switch power, which supply the
enough voltage and electrical energy that required by BizFAX system.

AC Input: 100~240V

DC Output: 12V,1A

Note: Prior to connect power, it’s better to use the three-phrase power
outlet of neutral-point joint or multi-function computer power outlet.

Please follow the below steps to connect power socket:

1. Push the switch on ‘OFF’ on power outlet.

2. Connect one head of the accessory power cable with the power input port

on BizFAX’s back panel, and plug the other head of power cable into 220V

power socket.

Push the switch on ‘ON’ on power outlet.

4. After wired up power, please check the Power LED on front panel whether
it lighted or not. Lighted LED indicates the correct operation of powers; if
unlighted, please repeat the step 1 to 3 again.

w
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Manage BizFAX

3.1 Manager Log in

Double click icon to open the IE browser, and input the IP address of

BizFAX server.
If user is first time to configure BizFAX by web, please use the BizFAX default

IP address to log in: http://192.168.5.150

The default Username is admin and password is password.

2} BizFAX - Busniess FAX Server - Microsoft Internet Explorer

File Edt Miew Favorites Tools  Help

eEack - '\) @ @ (b pSearch ‘?;\L{Favarites @ 8- (} [E -

Address @ http:ff192, 1685, 1 24static/configfindes, html

-
T=
oP
&
©
&

B IZE.-’}% 3\{ Busniess FAX Server

b BizFAX Configuration Panel

LBlzFax Client Software

o.'
/ ® Yeastar

User Login

Username:  admin

Password: sssesses

Lodin Reset

Wwhen you login to manage page or web-bizfax client,
if it can't access to next page, click here for help

Copytight 2009 Yeastar Technology, Co., Ltd. Al Rights Reserved.

Inkernet M
& ® B

Figure 3-1
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3.2 Basic

3.2.1 Extension

Fax extension has two kinds: physical fax machine extension (FXS) and virtual
fax extension.

2l BizFAX - Busniess FAX Server - Microsoft Internet Explorer

File Edt Mew Favorites Tools Help

eEack - J @ @ \fh pSearch ‘;’;{Favarltes @ szﬁ\; |I_T - |_J f @ ﬂ @ .‘3
Address @http:,l’,l’lgz.168‘5.lijstat\ciconflgjmdax‘htm\ b G0

Busniess FAX Server

3

P Extensions

Exfensions List Of Extensions
Trunks » FAX Machine Extensions
ol Pfizs Port Extension Full Name
Inbound Call Control & [ 601 FAx lﬁ (il I |—X LEET |
VR » Virtual FAX Extensions
Inbound Routes
+ Create Mew Exension | ¥ Delete Selscted Extensions | e
Blacklist 3
— li‘ Extension Full Name
em Settings
PES—— r 501 501 Yol Edit | % Delete
Systern Prompts (] 502 502 Yol Edit | | % Delete
E-Mall Seftings r 503 503 Yol Edit | % Delete
Mebwork Setings i
Metwork Jetings O 504 504 B Edit | [ Delete
File Sweep -
S r 505 505 Yol Edit | % Delete
Firmware update r &05 505 Nl Edit | |3 Delete
Resetand Reboot 1] 507 507 M Edit || 3 Delete
Password Sallings =] 508 508 i Edit | [% Delete b |
Reports r 509 509 Yol Edit | % Delete
EA¢Logs (] 510 510 il Eat | [ Delete |
System Infg
-0 4
# ® Yeastar
L]
a Done # Internet
Figure 3-2

3.2.1.1 Physical Fax Machine Extension

Edit Physical Fax Machine Extension

On the administration page of FXS extensions, click ‘Edit’ on the extension that
you want to edit, and modify the following information on prompt window:

1) Authentication

-Extension

The numbered extension, i.e. 1234, that will be associated with this particular
User / Phone.

2) Profile
-Name
A character-based name for this user, i.e. ‘Bob Jones’
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-Group
Extension’s Group.

Authentication
Extension @':

Port :

Profile
Mame & B0

Group © | ungroup -

o Save | #K Cancel |

Figure 3-3

3.2.1.2 Virtual FAX Extension

Virtual Fax Extension is an Account allows BizFAX Client or BizFAX web Client
to Login.

1. Add Virtual FAX Extension

Go to Extensions - Virtual FAX Extensions = Create New Extension

1) Authentication

-Extension

The numbered extension, i.e. 1234, that will be associated with this particular
User / Phone.

-Password

The password for the BizFAX Client, Ex: ‘12t3f6’

2) Profile

-‘Name

A character-based name for this user, i.e. ‘Bob Jones’

-Group

Extension’s Group.

-Mobile Phone

User’s mobile phone number.

-Send FAX to E-mail

This option defines whether or not FAX are sent to the Email Address as
attachments. Note: You need to have an smtp server configured for this
functionality.
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New Virtual FAX Extension X

Authentication

Extension & 501

Password ﬁ: e

Profile
Mame & Michael

Group:

Mohile Phone :

¥ Send Fax to E-Mail @ chy@yeastar.com
Note:lf you want to send FAX to erail please define E-Mail Settings from the 'E-hail Settings' panel.

o Save | #K Cancel |

Figure 3-4

2. Edit SIP Extension
Click ‘Edit’ on SIP Extension administration page or click ‘Modify Selected

Extensions’ to edit.
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3.2.2 Trunks

2 BizFAX - Busniess FAX Server, - Microsoft Internet Explorer \Z”E”z\

Fle Edt Wiew Favorites Tools  Help a.
Q- O DB G Pow oo B 3% €U LEED S
Address @http:,l’,l’192.168‘5.126,istat\c,|‘config,iindax‘htm\ b G@o

Busniess FAX Server

Links * | @&y -

>

} Manage trunks
Basic

Extenslons List Of Trunks

Trunks » PSTN Trunk
Outbound Routes

Trunk Name Analog Ports

PSTHL 2 o Edit |

Inbound Call Control &
VR

Inbound Routes
Blacklist

System Settings
General Settings
Systern Prompts
E-tail Settings
MNetwaork Settings
File Sweep

Backup and Restare
Eirmware update
Eeset and Reboat
Password Seftings

Reports
FAX L ogs
System Info

Yo

P
#® Yeastar

4

&) Dane & Internet

Figure 3-5

Edit PSTN Trunk (FXO Port)

On PSTN Trunk administration page, click ‘Edit’ on selected trunk and modify
information on prompt window:

1) General

‘-Trunk Name

A unique label to help you identify this trunk when listed in outbound rules,
incoming rules etc. Ex: 'Port 5

-Audio Setting

Normally you should not have to adjust your analog ports beyond the initial
calibration. Should you still need to fine tune your audio settings, please use the
adjustments.

2) Advanced Options

-Busy Detection

Busy Detection is used to detect far end hang up or for detecting busy signal.
Enable to turn this feature on.

-Busy Count

If Busy Detection is enabled, it is also possible to specify how many busy tones
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to wait for before hanging up. The default is 4, but better results can be
achieved if set to 6 or even 8. Mind that the higher the number, the more time
that will be needed to hangup a channel, but lowers the probability that you will
get random hangups.

-Busy Pattern

If Busy Detection is enabled, it is also possible to specify the cadence of your
busy signal. In many countries, it is 500msec on, 500msec off. Without Busy
Pattern specified, BizFAX will accept any regular sound-silence pattern that
repeats <Busy Count> times as a busy signal. If you specify Busy Pattern, then
BizFAX will further check the length of the sound (tone) and silence, which will
further reduce the chance of a false positive.

-Caller ID Start

This option allows one to define the start of a Caller ID signal:

Ring, to start when a ring is received (Caller ID Signaling: Bell _USA, DTMF).
Polarity, to start when a polarity reversal is started (Caller ID Signaling: V23_UK,
V23 JP, DTMF).

Before Ring, to start before a ring is received (Caller ID Signaling: DTMF).
-Caller ID Signaling

This option defines the type of Caller ID signaling to use: bell (bell202 as used
in the United States), v23_UK (as used in the UK), v23 JP (as used in Japan), or
dtmf (as used in Denmark, Sweden, and Holland).

N’

Trumk Marne & PSTN

Audio Setting O [soft v

Advanced Options

— -

Busy Detection &, [ves h Busy Count @ 4
Busy Pattern € Caller ID Start € | Ring ¥

Caller ID Signalling € | Bell-Usa v

o Save | #® Cancel |

Figure 3-6

3.2.3 Outbound Routes

Outbound routing mainly works for guides outgoing calls to go through trunks.
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File Edt Mew Favorites Tools Help

@Eack - \_:) @ @ \—_'h pSearch *Favarltes @ D’:?v :\F ILT - I_J f @ ﬂ 0 .'3
Address @http:,l’,l’lgz.168‘5.IZEJStat\CJ'CanIg,iIHdBX‘htm\ v Go Links > | @3 -

» Manage Outbound Routes &

asi
Extensions + Mew Outhound Route

Trunks
Quthound Routes

Route Name Dial pattern

outhound_default 9 N Edlit | X Delete |

Inbound Call Control
R

Inbound Routes
Blacklist

System Settings
General Seftings
Systern Prompts
E-Mail Settings
Netwark Settings
File Sweep

Backup and Restare
Firmvyare update
Reset and Reboot
Password Settings

Reporis
EAX Logs
System Info

Yo

)
" Yeastar

|

@ Done # Internet

Figure 3-7

3.2.3.1 Create Outbound Route

Click ‘New Outbound Route’ and fill in the responding information on prompt
window.

1) General

-Route Name

Name of this Outbound Route. Ex: 'Local’ or 'LongDistance' etc.

-Dial Pattern

In dial patterns, some characters have special meanings:
X ... Any Digit from 0-9
Z ... Any Digit from 1-9
N ... Any Digit from 2-9
[12345-9] ... Any Digit in the brackets (in this example, 1,2,3,4,5,6,7,8,9)
. ... Wildcard, Matches Anything Remaining; i.e. 9011. Matches anything
starting with 9011 (excluding 9011 itself)
! ... Wildcard, causes the matching process to complete as soon as it can
unambiguously determine that no other matches are possible.
For example, NXXXXXX would match normal 7 digit dialings, while
INXXNXXXXX would represent a three digit area code plus phone number,
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proceeded by a one.

-Strip

Allows the user to specify the number of digits that will be stripped from the
front of the dialing string before the call is placed via the trunk selected in ‘Use
Trunk’ One might; for example, want users to dial 9 before their long distance
calls; however one does not dial 9 before those calls are placed onto analog lines
and the PSTN, so one should strip 1 digit from the front before the call is placed.
-Prepend digits before dialing

Allows the user to specify digits that are prepend before the call is placed via the
trunk. If a user's trunk required 10 digit dialing, but users were more
comfortable performing 7 digit dialing, this field could be used to prepend a 3
digit area code to all 7 digit strings before they are placed to the trunk. User may
also prepend a 'w' character for analog trunks to provide a slight delay before
dialing

-Calls From Extensions

Defines the Extension that calls, matching the specified pattern, will be placed
through.

-Make Outbound Calls on Trunk

Defines the Trunk that calls, matching the specified pattern, will be placed
through.
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Edit Dutboud Route o

Route Name @ 2

Dial pattern & 9

Strip @ 1 digits from front

Prepend these digits ] hefare dialing
Calls From Extensionis) o
Available Extensions Selected
B S01¢virkual) S
S02(Yirkual) E|
ﬂ S0 Virkual) 1~
S04virkual)
S05¢virkual)
ﬂ EO6Virtual)
S07{Virkual)
SoEvirkual) hal
Loty
Make Outhound Calls o &
Available Trunks Selected
i PSTM{Analag FXO)

Loy

[ [t [ [

W S_ave—| X Cancel |

Figure 3-8

3.2.3.2 Delete Outbuond Route
Click ‘Delete’ on selected trunk to remove the trunk.
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3.3 Inbound Call Control

3.3.1 IVR

When there’s an incoming call aims at Auto Attendant, BizFAX will play the IVR
and guide the caller to the required extensions (such as ‘Welcome to XX
company, for sales press 1, for technical support press 2, for operation press O,
or dial ext. number directly. System will transfer the call to corresponding
extension according to DTMF).

2} BizFAX - Busniess FAX Server - Microsoft Internet Explorer

File Edt Miew Favorites Tools  Help
eEack A q @ @ (:j psaarch *Favarites @ Bv ,{_% v = I_J f @; ﬂ @ ‘3
Address @http:.l’.l’lgz.168‘5.lzsjstat\ciconfigjindax‘htm\ & Go

Busniess FAX Server

Links ** | @y -

>

P manage IvR &

# Create New VR IVR

Extensions

Trunks
Outhound Routes

Number Allow Dialing Other Extensions
IVR_default 660 Yes i Edit ‘ X Delete

Inbound Call Control
IR

Inbound Routes
Blacklist

System Settings
General Seftings
System Prompis
E-Mail Setfings
Metwork Settings
File Sweep

Backup and Restore
Firrvare update
Reset and Rebaot
Password Settings

Reports
FAXLogs
Systern Infg

£

# Internet

Figure 3-9
3.3.1.1 Auto Attendant
Click ‘Create New IVR’ as shown on Figure 3-10.
1) General
-Number
My PBX treats IVR as an extension; you can dial this number access the IVR.
-Name
A name for the IVR
-Prompt
A Prompt file for the IVR.
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-Custom I'VR Prompt

If you want to use your prompts, please click this link, and upload the sound file.
-Play Times

The times of the selected IVR prompt file will be played.

‘WaitExten

Wait for the user to enter a new extension for a specified number of seconds.

-Allow Dialing Other Extensions
Check this option if the user want to dial extensions directly.

2) Key Press Events

Allow key press events will cause the system to listen for DTMF input from the
caller and define the actions that occur when a user presses the corresponding
digit.

-Time Out

Defines the timeout action. Timeout occurs when no DTMF entry is detected for
3 times after the IVR has finished playing its prompts.

-Invalid

Defines the invalid action. The invalid action is triggered if the user enters a
DTMF that is not otherwise defined for the IVR.

-Detect FAX Tone

The detect fax tone action is triggered if it receive the fax tone and user not
input the extension number.
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New IVR x

Number € 660

Name & welcorme

Prompt @ | defaule ~|  Custom I¥R Prompts

Play times &
WaitExten ) ;

& keyPress Events

Detect fax tone

[~ & allow Dialing Other Extensions

|01

o

Key Action Destination
0 | Connect to Extension v | | User Extension -- 501 |
1 | Connect to Extension v | | User Extension - 502 v/
2 Mo Action | 4
3 [No Action v 48
4 Mo Action v P
5 Mo Action v [AY
5 | Mo Actian | |
7 | Mo Actian |
8 | No Action ~
9 Mo Action |
# Mo Action |
* | Mo Action v |
TimeOut & | Connect ko Extension ¥ | | User Extension -- 501 v|
Trrvalid & | Connect to Extension v | | User Extension -- 501 |

o Save | #K Cancel |

Figure 3-10

3.3.1.2 Delete IVR
Select the item you’d like to remove and click ‘Delete’ key.

3.3.2 Inbound Routes

Inbound routing mainly works for guides incoming calls to reach destination
extension within the working hours.

Page 22



0
T:Yeastar BizFAX-E100 Server User Manual

File Edt Mew Favorites Tools Help

@Eack - \_:) @ @ \—_'h pSearch *Favarltes @ D’:?v :\F ILT - I_J f @ ﬂ 0 .'3
Address @http:,l’,l’lgz.168‘5.IZEJStat\CJ'CanIg,iIHdBX‘htm\ v Go Links > | @3 -

» Manage Inbound Routes

5
Extensions + Mew Inbound Route

Trunks
Quthound Routes

Route Name Pattern

inbound_default N Edlit | X Delete ‘

Inbound Call Control
R

Inbound Routes
Blacklist

System Settings
General Seftings
Systern Prompts
E-Mail Settings
Netwark Settings
File Sweep

Backup and Restare
Firmvyare update
Reset and Reboot
Password Settings

Reporis
EAX Logs
System Info

Yo

)
" Yeastar

|

@ Done # Internet

Figure 3-11
3.3.2.1 Create Inbound Route
Click ‘New Inbound Route’ to enter to the page.
1) General
-Route Name
Name of this Inbound Route. Ex: "'pstncallin’ etc.
-Pattern
Define the Caller ID Number to be matched on incoming calls. Leave this field
blank to match any or no CID info.
In patterns, some characters have special meanings:
X ... Any Digit from 0-9
Z ... Any Digit from 1-9
N ... Any Digit from 2-9
[12345-9] ... Any Digit in the brackets (in this example, 1,2,3,4,5,6,7,8,9)
. ... Wildcard, Matches Anything Remaining; i.e. 9011. Matches anything
starting with 9011 (excluding 9011 itself)
! ... Wildcard, causes the matching process to complete as soon as it can
unambiguously determine that no other matches are possible.
For example, NXXXXXX would match normal 7 digit dialings, while
INXXNXXXXX would represent a three digit area code plus phone number,
proceeded by a one.
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2) Trunk Sequence

This selection shows all Trunks. Checking Trunk here makes them a member of
the Inbound Route.

3) Destination

You can choose the options for receive the incoming fax.

Edit Inbound Route X

General
Route Mame & ; FaxIn
Pattern ﬁ':
Trunk Sequence o
Available Trunks Selected
E PSTH(ARalog Frd)
=]
<]
Lot
Destination
" Public FA¥ Folder
VR | IR - 3333 |
 FAX Machine Extensions |6E|1 v|
& Wirtual FAX Extensions
Awvailable Extensions Selected
502 ~ o 501
03 3
S04
505 B ﬂ
506
507 ﬂ
S08
509 w
o L1eed
of Save | 3K Cancel |

Figure 3-12

3.3.2.2 Delete Routes

Select the item you’d like to remove and click ‘Delete’ key.

3.3.3 Blacklist

Blacklist is an easy to use function which used to block an incoming call; it will
refuse any incoming call which you don’t want to answer.
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If the incoming call number in the blacklist, system will prompt “The number
you have dialed is not in service. Please check the number and try again”, and
then system hang up the call.

2l BizFAX - Business FAX Server - Microsoft Internet Explorer
File Edt Mew Favorites Tools Help @

Qo - O X [ G P frrome @ 3% 6 -1 L BB

@ http:ff192, 1685, 126)static/configfinde:x, html b G0

Links > | @3 -

Address

fT AW :
HA Busniess FAX Server
BizEAX Logout

} Manage Blacklist

Basic

Exfensions + Mew Blacklst Manage Blacklist

Trunks
Quthound Routes |

Mo Blacklist defined ! ‘

S

Inbound Call Control =
R

Inbound Routes
Blacklist

System Settings
General Seftings
Systern Prompts
E-Mail Settings
Netwark Settings
File Sweep

Backup and Restare
Firmvyare update
Reset and Reboot
Password Settings

Reporis
EAX Logs
System Info

o.'
/ ® Yeastar

a Done # Internet

Figure 3-13
3.3.3.1 Create Blacklist
Click ‘New Blacklist’ to enter to the page.

New Blacklist

Blacklist Nurber & .

of Save | K Cancel |

Figure 3-14
-Blacklist number
Enter the number you want to block.
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3.4 System Settings

3.4.1 General Settings

1) FAX Settings

-The fax left page header: this value will be showed on the fax left page
header when sending out.

-The fax right page header: this value will be showed on the fax right page

header when sending out.

-The retry times for failed faxes: When system failed to send fax, it will
try X times as configured.

-The retry times if called is busy: The callee is busy when system send

fax, it will try X times as configured.

2) Prompt callee send FAX signal

-Prompt callee send FAX signal

Sometimes customers use the Two-in-One machine that sends fax and
receives telephone call by the same equipment. When you want to send fax
to those customers, please remind them to send a fax single.

.Prompt
The prompt tone asks for a fax signal from callee.

-Play times
The times of the selected prompt file will be played.

-WaitExten
Wait for the user to enter a new extension for a specified number of seconds.

3) Date & Time
Set the date and time for BizFAX Appliance.
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2} BizFAX - Busniess FAX Server - Microsoft Internet Explorer
Eile  Edit

Qo - © 1) [@ G oo frrome @3- 5 6 LBEDS

Address a httpeff192. 1685, 126static/configfindes, html

B iZ 1-3_,’-"1_:;{ Busniess FAX Server

P General Settings &

View Favorites  Tools  Help

v B ks ? @ -

» )

Basic )

Extensions FAX Settings

Trunks .

Guthound Routes The fax left page header:  BizFAX-E100

The fax right page header @: |ext=(ext)

—~

Inbound Call Contrel =/
R The retry times for failed faxes: 0

Inbound Routes The retry times if callee is busy: 0
Blacklist

Prompt callee send FAX signal
System Settings

General Setfings v Prompt callee send FAX signal

Syslern Prormpts

Systetm Profmpts Prompt | waitToneSound-cn % | Custom Prompts 3
E-Mail Setfings =
Metwork Settings Flay times® -3 M

File Gween waitExten & :

Backup and Restore

Firrvare update Date 8 Time

Reset and Rebaot
Password Settings

Server Time: Fri Oct 09 4:47:59 2009

Reports Time Zone: | GMT-05:00 Pacific Time (US and Canads) >

FAXLogs
Systern Infg

@ Automatically Synchronize With An Internet Time Server

NTP Server pOOl.ntp.CE

 Set New Date £ Time Manually

Date {

e/ [ ¥

W Save ¥ Cancel

& Internet

Figure 3-15

3.4.2 System Prompts

Admin can upload prompt as follow:

1) Click ‘Upload a system Prompt’.

2) Click ‘Browse’ to choose the file to upload.

3) Click ‘Upload’ to upload the selected Prompt.

Note: The sound file format: GSM 6.10, 8.000kHz, Mono, 1kb/sec

Upload System Prompt X

Wk format:GSh 6,10 2,000 kHz, Mono, 1kbfsec

Chaose file to Upload@ W ..

Upload *® Cancel

Figure 3-16
3.4.3 E-Mail Settings
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-E-mail Address
The E-mail Address that BizFAX will use to send voicemail to users’ email.

-Password
The E-mail password.

-SMTP Server

The IP address or hostname of an SMTP server that the BizFAX may connect to,
in order to send e-mail notifications of your voicemails;

i.e. mail.yourcompany.com

-Port
The SMTP Port

-Use SSL/TLS to send secure message to server
This functions, must be selected for gmail and exchange server.

3.4.4 Network Setting

-DHCP

If this option is set, BizFAX will use DHCP to get an available IP address from
your local network.

-Hostname
Set the host name for BizFAX Appliance.

-1P Address
Set the IP Address for BizFAX Appliance.

-Subnet Mask
Set the Subnet Mask for BizFAX Appliance.

-Gateway
Set the Gateway for BizFAX Appliance.

-Primary DNS
Set the primary DNS for BizFAX Appliance.

-Secondary DNS
Set the secondary DNS for BizFAX Appliance.
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2l BizFAX - Busniess FAX Server - Microsoft Internet Explorer

File Edt Mew Favorites Tools Help

eEack - J @ @ \fh pSearch ‘;’;{Favarltes @ szﬁ\; |I_T - |_J f @ ﬂ @ .‘3
Address @http:,l’,l’lgz.168‘5.IZEJStat\CJ'CanIg,iIHdBX‘htm\ b G0

Busniess FAX Server

Links > | @3 -

P Netwaorking setting

Exfensions Network Setting
Trunks

Outhound Routes DHCP:

S

Inbound Call Control # Hostname: BizFAX-E100
R

Inbound Routes
Blacklist

IF Address: 192.188.5.150|

Subret Mask:  255,255,255.0

System Settings Gateway: 19216851

General Seftings
Systern Prompts
E-Mail Settings Secondary DNS:
Netwark Settings
File Sweep

Backup and Restare

Eirmare update o Save | | ¥ Cancel

Reset and Reboot
Password Settings

Primary DNS: 192.168.5.1

Reporis
EAX Logs
System Info

o®
"Yeastar

[%

a Done # Internet

Figure 3-17

3.4.5 File Sweep

-File Sweep when available space is less than:

The default value is 30M.

-Delete

If the space less than the setting value, it will delete 50 faxs (50 is the
default value).

3.4.6 Backup and Restore

Backup / Restore BizFAX’s Configuration.
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2l BizFAX - Business FAX Server - Microsoft Internet Explorer

File Edt Mew Favorites Tools Help

eEack - J @ @ (b pSearch ‘?:\?Favarltes v@ Bv ..?; ll_? - |_J f @\g ﬁ @.’3
Address ahttp:,l’,l’lgz.168‘5.IZEJStat\CJ'CanIg,iIHdBX‘htm\ b G0

Busniess FAX Server

Links > | @3 -

P File Sweep W

Exensions File Sweep
Trunks
Outhound Routes

File Sweep

File Swaep when available space is less than: 30 I

S

Inbound Call Control =
R

Inbound Routes
Blacklist

Delete: 20 Faxs

of Save | (3 Cancel

System Settings
General Seftings
Systern Prompts
E-Mail Settings
Netwark Settings
File Sweep

Backup and Restare
Firmvyare update
Reset and Reboot
Password Settings

Reporis
EAX Logs
System Info

o.'
/ ® Yeastar

[%

a Done # Internet

Figure 3-18

3.4.7 Firmware Update

With new version, we can upgrade the firmware in GUI through a TFTP
Server or HTTP URL.

Enter your TFTP Server ip address and firmware name, just click ‘start’, you
will update your firmware easily.
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2l BizFAX - Business FAX Server - Microsoft Internet Explorer

File Edt Mew Favorites Tools Help

eEack - \_) @ @ \:’h pSearch *Favarltes @ Bv% |I_T - I_J f @ ﬂ @ .‘3
Address @http:,l’,l’lgz.168‘5.IZEJStat\CJ'CanIg,iIHdBX‘htm\ b G0

Busniess FAX Server

Links > | @3 -

» Update Appliance Firmware &

Extensions
Trunks

Download Image From A :
Quthound Routes

.\ & e

Inbound Call Control & HTTP LRL TFTP Server
R HTTF URL :

Inbound Routes Reset Corfigs : [

Blacklist

+ Start

System Settings
General Seftings
Systern Prompts
E-Mail Settings
Netwark Settings
File Sweep

Backup and Restare
Firmvyare update
Reset and Reboot
Password Settings

Reporis
EAX Logs
System Info

o®
"Yeastar

[%

a Done # Internet

Figure 3-19

3.4.8 Reset and Reboot

-Reboot Appliance
Warning: Rebooting the appliance will terminate all active calls.

-Reset to Factory Defaults

Warning: By resetting your System to factory defaults, you will lose all your
configurations! You can't cut off the electricity during restarting till the RUN
state light blink, otherwise it will cause the failure performance.
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File:

eEack © '\)

Edit View Favorites

Taals

N E G Do forne @ -2 6 -1 LEHOB

\168,5,126static/configjindss. himl v Go Links > | @3 -

Help

Busniess FAX Server

} Reboot Appliance & Reset to Factory Defaults

o

Basic

Extensions Reboot Appliance

Trunks
Outbound Routes Reboot Appliance

S

Inbound Call Control %/
VR Warning: Rebooting the appliance will terminate all active calls,

Reboot Mow
Reset To Factory Defaults

Reset to Factory Defaults

Inbound Routes
Blacklist

System Settings
General Seftings
Systern Prompts
E-Mail Settings
Netwark Settings
File Sweep Warning: By resefting your Systern to factory defaults, you will lose all your (@@nfiglrations!

Backup and Restore You can't cut off the electricity during restarting till the RUN state light bilifk) other#ige it will cause the
Firmware update failure performance.

Reset and Reboot
Password Settings

Reset to Defaults -

Reporis
EAX Logs
System Info

o.'
/ ® Yeastar

a Done # Internet

Figure 3-20
3.4.9 Password Settings
The default password is ‘password’, we need change that first.

Enter new password and click update, then the system will prompt you re-login
using your new password.
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2l BizFAX - Business FAX Server - Microsoft Internet Explorer

File Edt Mew Favorites Tools Help

eEack - J @ @ \fh pSearch ‘;’;{Favarltes @ szﬁ\; |I_T - |_J f @ ﬂ @ .‘3
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File Sweep

Backup and Restare
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Reset and Reboot
Password Settings
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System Info
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a Done # Internet

Figure 3-21

3.5 Reports

3.5.1 FAX Logs

FAX Log captures all fax details: Date, caller number, callee number, Subject,
type, Status and so on. For administrator’s convenience, admin can search
information by time, type, subject and Status, and export them into CSV file.
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2l BizFAX - Business FAX Server - Microsoft Internet Explorer

File Edt Mew Favorites Tools Help
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Figure 3-22
3.5.2 System Infomation

State:
Information about Server State and FAX State.

Version:
Information about Hardware version, Firmware version.

Network:
Information about Hostname, MAC, IP Address, Mask, Gateway and DNS.

Disk Usage:
Disk usage information.
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A BizFAX - Business FAX Server, - Microsoft Internet Explorer
Edit
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Figure 3-23
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Use BizFAX

Make two examples for the below typical applications:

» Usage of sending fax
» Usage of receiving fax

For example, BizFAX has virtual fax Extensions 501 and 502 and physical fax
Extensions 601; PSTN Trunk OutPSTN1.

Out
PSTN 1

PSTN Trunk

BizFAX

Virtual Fax Ext

Physical Fax Ext.

Ext. No.
501

Ext. No.
502

Ext. No.
601
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4.1 Usage of Sending Fax

Out

PSTN  Trunk Port] PSTN1
Access Code*“9”

PSTN Trunk

BizFAX

Virtual Fax Ext Physical Fax Ext.
Ext. No. Ext. No. Ext. No.
501 502 601

On the above demonstrated environment:

Suppose the settings of outbound routes are as below:
Route Name: 9
Apply this rule to: fax from extension(s)——AlIll Extensions
Make outbound calls on: Trunk Sequence—— All PSTN trunks
Other: Deleted Prefix Count——1

Send fax through physical fax machine
If the extension 501 wants to send a fax to 0123-1234123, he can dial:
9+0123-1234123
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4.2 Usage of Receiving FAX

Out
PSTN1

PSTN Trunk

BizFAX

Virtual Fax Ext Physical Fax Ext.
Ext. No. Ext. No. Ext. No.
501 502 601

On the above demonstrated environment:

Suppose the settings of inbound routes are as below:
Route Name: All
Source: Trunk Sequence——AIl Trunks
Route calls to: Destination——IVR 7777

For example: All the incoming calls will be answered by IVR 7777 and then
forwarded to corresponding extension according to the transferring list.

<Finish>
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Introduction

BizFAX paperless fax system is an intelligent fax server that combines the
traditional fax technology and network technology.

After connected the PSTN telephone line and built up the connetion with the
LAN or internet, by using the BizFAX Client software on their computers,
users can easily to create a safe, efficient and affordable fax system for
enterprise. Moreover, all of these are electronic processing on computer
without a piece of paper.

Through BizFAX Client software, every user is able to get the auto-receive,
auto-fax and management features. When sending a fax, users only need to
submit file to BizFAX server, and then system will auto fax the files in order.
Back up the faxes automatically and allow users to easily manage them. It's
helpful to improve the progress of company internal approval, add personal
sighature, make company seal, and Mail to FAX and FAX to Mail.

The advanced integration of BizFAX with internet, email and SMS help users
to send and receive faxes at any time any where.
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Operating Environment

2.1 Hardware Environment

CPU: Recommend to use more a CPU that power than INTELPIII500
Memory: Recommend to use more than 128MB RAM
Hard Disk: Atleast 1 G

2.2 Software Environment

Operating system: Windows XP, Windows 2000, Windows 2003, Windows Vista,
Widows 2008, Windows 7.
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Install BizFAX Client

This section shows how to install BizFAX Client software on the PC.
1. Download Client software from

http://www.yeastar.com/download/BizFAXClientSetup.exe

2. Doube-click the ‘BizFAXClientSetup.exe’, Welcome to the BizFAXClient
Installation screen will come up.

1 Tnstalling BizFAY Client

Languages o
Select preferable language. '!'h“-@
Select vour preferred language for this installation,
Click Mext to continue the installation,
A= W (Chinese Traditional)
i’ﬁ'ﬁqﬂjﬂjichinese Similiﬁedi
Mext = ] [ Exit

Figure 3-1

3. Click Next to continue.
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Welcome to the BizFAX Client

Installation!
:;&_,f ~ This setup pragrar will install BizFaX Client an vour carmputer,
e Lf\ Click Exit if you do not want to install this application, Click Next
et WS to continue the installation,
e

wARMING: This program is protected by international copyright
] law and
treaties,

Unautharized repraduction or distribution of this prograrm, or any
portion of it, may result in severe civil and criminal penalties and
will be prosecuted to the maximum extent of the law,

< Back | [ Exit

Figure 3-2

4. Read through the software License Agreement, select ‘I agree with the
above terms and conditions’, and then click Next to continue. See
Figure3-3.

42 Tnstalling BizFAY Client

License Agreement

To proceed with the installation, you must accept this License
Agreement. Please read it carefully,

Entering into this Agreement: (BizFax Client) ”

This End User License Agreement constitutes a valid and binding agreement
between veastar's BizFax software {'Software') and vou, as a user, for the use
of the Software.

Article 1 License and Restrictions

1.1 License. Subject to the terms of this Agreement, Yeastar hereby grants vou
a limited, personal or company, commercial, exclusive, sub licensable,
assignable, charge license to download, install and use the Yeastar Software an
Your computer,

[*]I agree with the above terms and conditions

< Back | [ Exit

Figure 3-3
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5. Click ‘Next’ after going over the provisions

42 Tnstalling BizFAY Client

Readme
Flease read the following information,

s

BizFAX Client is a virtual fax extension that works with BizFAX Server, Mot anly
receive fax automatically and save it as electronic file, but also rmake outbound
call manually and automatically to send a fax,

Faxes are changeable ammong BizFaX Clients (virtual fax extensions), Maoreover,
users can send the electronic file to fax machine extension for print and also
receive the faxes fram fax machine extension,

BizFaAx contains a BizFAX Printer module and a BizFax Editor module, BizFax
Printer can easily convert docurnents as doc, xls or pdf to tiff format; BizFAX
Editor help user to dramatically improve the efficiency in doing office works like
make annotations, signature and stamp on a docurment,

once installed, there will be a shortcut of BizF&X client on the desktop, Double
click it and beqins to run.

< Back | [ Exit

Figure 3-4

6. The Destination folder screen will offer you the option where you would
like BizFAXClient to be stored on your computer. Click Next to continue.

42 Tnstalling BizFAY Client

Destination folder

Select a destination folder where BizFax Client will be
installed,

s

Setup will install files in the fallowing falder.

If you would like to install BizFAR Client into a different folder then click
Browse and select another folder,

Cestination folder

CiWProgram Filesyveastars\BizFAxClient

< Back | [ Exit

Figure 3-5
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7. A screen pop-up to notify you that:
(1) Launch BizFAXClient after installation.
(2) Create desktop shortcut;
(3) Start BizFAXClient when | start Windows
Enable the options by your own demands, and then click Next.

42 Tnstalling BizFAY Client

Select fram the following installation options,
Click Next to begin the installation. Click Back if you would like to change the
installation information,

[“|Launch BizFax After Installation:
[¢] Create Desktop Shortcut
[#] Start BizFax when I start Windows

< Back ] [ Mext = ] [ Exit

Figure 3-6

8. Enter into the Installing Files, system begin to installation step, which will
last for a while.
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42 Tnstalling BizFAY Client

Installing Files

Copving BizFax Client files to your computer, %’J;L'-ﬁf'

To interrupt or pause the installation process, click Cancel,

Directory: d:%Program FileshreastariBizFaxClient
Filz: GdiPlus.dll

(NNRNNRNRRNRANRANRRRNRANR )

Figure 3-7
9. When the installation is complete, a screen pop-up to notify you that the
software is installed successfully. Click Finish.

2 Tnztalling BizFAY Client

BizFAX Client has been
successfully installed!

Click Finish to complete the installation,

Figure 3-8
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Usage of BizFAX Client

4.1 Log in Client

After the installation, you can enjoy the powerful functions BizFAXClient

offers.

Bl

(i
Double-click shortcut ==:and launch BizFAXClient. Please enter your Ext.
number and password and then click ‘Sign In’, see Figure 4-1.

File

Extenzion
5007 -

Paszsword

B E R

S:i.gn ne in when Client starts

Start Client when computer starts

Please pay attention when you
login at first time:

Please click “Tools’ on
menu->Options, and enter the IP
address of BizFAX Server on Figure
4-2.You can get this IP from Admin.
About Ext. and Password

To obtain the Extension and
Password from your system Admin
before you log in BizFAXClient.

Figue 4-1

www.yeastar.com
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FizFAY Client — Options

Systam

Audio settings

Server IF address: 192, 168, 5. 66 |

Fath for printed files:

d:\Frogram Files\Yeastar\BizFANClient'\Fas E]

Coe J[ w8 [ 5A® ]

Figure 4-2

4.2 Send FAX

After installed the BizFAXClient software, system will create a virtual fax

o

" in printer folder in the control panel.

4.2.1 Sending fax from application programs

Application programs adopt the ‘Virtual Print’ way to realize the fax function.
All the programs are able to send fax by BizFAX Fax Printer as long as they
support print function. Open any type of document that supports print,
select ‘Print’ and see a prompt dialog box as Figure 4-3:
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eane 2|

General |

i~ Select Printer

2 = (b & 53

soft Auko Microsoft Auta Microsoft HP LaserJet Microsol
U... Office Docu.., Office Docu.., 1020 on CHY - Office Dol =

1 |
Statuz:  Ready [ Printtofile  Prefersnces |
Location:

Caomment; Fitid Prirter... |
~ Page Range

Al Murnber of copies: I'I 3:

) Selection £ Cument Page

" Pages: I [" Collate |jl-
Bopd

Frint I Cancel | Apply |

Figure 4-3
Select ‘BizFAX’ on printer list and click ‘OK.
System will generate a ‘Create new fax’ window and the file would be printed
as TIFF to add into task list.

& FAX TEST |ZJ|E|IZ|
= Ef =
Send Edit Sawve
1o ]9550330?

Subject  |[FAXTEST

fmfreviewl
[dadd file [LDelete file
S D:“Frogram Files\Teastar\BizFAXCLient\FaxFile\imagel. tiff

Figure 4-4
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4.2.2 Sending fax from Client software

(1) Enter into FAX tag, click ‘Create’ to create a new fax.
(2) Click ‘add file’ to select the file you want to fax from computer.

Note: Only the file in *.bmp. *.dib. *.jpg. *.jpeg. *.png. *.doc. *.docx. *.xls.
* xlsx. *.pdf. *.tif. *.tiff. *.txt or *.rtf format can be added in this way. The

files in other formats could be opened by the application programs and sent out
through ‘Prinit’.

@ FAE TEST M=1E3
@ 24
Send Edit Save
lTo |95503307

Subject |FA)( TEST

E' le l-isa _E_review!
[(d4dd file | dDelete file
EDZ\Program Files'Yeaztar'BizFAClient'FaxFilelimagel. tiff

Figure 4-5
Merge multiple files to fax once

If user wants to fax multiple files at the same time, he can click the ‘Add file’
button again to add other files into task list, or he can use the application
programs to open the files at first and choose ‘Print’'to send them into fax
list.

Beside the adding option, user is also able to delete the unnecessary files
from list after clicked ‘Delete File’button.
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@& FAX IESI

% 2

Send Edit Sawve

Wl To 95503307

Subject  |[FAXTEST

E’ le l-isa Ereview!

[dadd file [LDelete file

[ D:"Frogram Files\Teastar'BizFAXCLient\FaxFile 200951514435, tiff
ED: “Program Files\Teastar'BizFANClient ' FaxFile \BizFaxFile3d. t1ff
S0 “Frogram Files\Teastar\BizFAXCLient\FaxFile\Z0095295499. tiff
‘ED: “Program Files'YTeastar BizFAXClient'\FaxFile\imagel. tiff

Figure 4-6

4.2.3 Description of ‘Create a New Fax’ Menu

4.2.3.1 Receiver (Fax number)
There are two ways to enter receiver (fax number):
1. Enter the numbers directly as Figure 4-7
The right way of entering fax number: for example here a company in
Xiamen city of China, city area code is 0592 and country code is 0086 :
(1) local fax number in this company: 5503307
(2) doemstic long distance fax number: 05925503307
(3) international long distance fax number: 00865925503307
Note: 9+5503307 or 0+5503307
When an ext. user sends a fax, he needs to plus a prefix number 0 or 9 that
usually required by the PBX phone system before dialing the receiver’s fax
number.

'_|,TD |95503307;905925503307;900865925503307

Figure 4-7

2. Click on ‘Receiver’ and select contacts from address book.
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Select Recipients E|
Find name:
!-ax extensiona _Fon‘t ac‘ts‘-[
Hame Fax 5503307
& David SE03307
& Tessie 0592-5503307
&, Michael B2E1511
Irput runbers
[ ok | [ cCancel |

Figure 4-8
Select contacts’ fax number and click ‘Add’, it shows the selected number on
right box, click ‘OK’ to finish.

4.2.3.2 FAX Subject
Mark the faxes for easy manageable and searchable.

4.2.3.3 Fax Content

Fax File List
1) Add Fax: Select one or multiple files from computer to fax out once
2) Delete Fax: Delete file(s) from fax file list

Preview:
User is able to view and check the selected fax file through ‘Preview’.

Edite:
User is able to add signature or make notes on selected file. Click ‘Edit Fax’ to
amend contents, seal and add signature directly.

4.2.4 Delay to Send FAX

BizFAX is able to send fax in specific time that set up by users. User can set
up an idle time or the most cheapest call rate period to delivery fax and this
function is specially useful to send the international fax because of the time
difference.
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& e RS AN

e, -

= A <3

fobrs RELTE REEEH $TER
CLEEA |96503307

-1 [FEFT R TEE,
EEEEES 2009~ 822 v |10:43:06 3 |

ErumwlFAE )
[t [ Messoit
I D:M\Frogram Filezs\Yeastar\BizFANCLient \FaxFile 20005205400, tiff

Figure 4-9

4.2.5 FAX Broadcast

System allows user to fax a same file to different numbers at the same time,

which means fax broadcast.

There are two ways to get fax broadcast service:

1. Enter fax numbers directly and separate them by semi-colon. See Figure
4-10
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‘ FAX Froadcast T”EJ@
@ 2 d
Send Edit Save
) To ]95503307:95503302:905925503301 (B00865925503303

Gubject |Fax Broadcast

File list] Freview!
[Q4dd file [[Delete file
]J: “Program Files'Yeastar\BizFAXClient\FaxFile\20095208409. tiff

Figure 4-10

2. Click ‘Receiver’ and select multiple contacts from address book to add
into right box as Figure 4-11.

Select Eecipients El
Find name: | |

!a}t ext ensiuna Fﬁntact‘

Name | Fax BZZ1511

&, Dawid 5503307 QEEOSE0T

& Tessie \ ‘/ 50592—5503307

2 Michael 6221511

<<Remowve
Irput rumber: 05925503307 [ _aad> ]
[ ok | [ cancel

Figure 4-11
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4.2 .6 Forward Fax

User can transfer the received faxes to both internal extension users and
external contacts.

1. Forward to internal extensions

Click the right mouse on the selected fax and choose ‘Forward’ from the
pull-down menu. Click on ‘To’ to select receivers from ‘Fax Extensions’ as
Figure 4-12.

Double click on the extension names or click ‘Add’ to add the selected
extensions into right list.

Select Recipients E|
Find name:

_Fax ex‘tension’_!ﬁon‘tac‘ts]

Name Ext. no Lo SDE E

g Fipige 5001 |

le Eooker S00z2

Mo Aften 003

I Gytha S004

tu' Aokl ey 005

I Booth SO0

H hida 5007

Jioj Hermony 5005

tu' Aoton 5003

tu' Borden S010 v

¢ W >

Input number: I_—— (V¢

[ ok | [ cCancel

Figure 4-12
2. Forward to external contacts

Click the right mouse on the selected fax and choose ‘Forward’ from the
pull-down menu. Click on ‘To’ to select receivers from ‘Contacts’ as Figure
4-13.

Double click on the extension names or click ‘Add’ to add the selected
contacts into right list.
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Select Recipients E|
Find name:
Fax extensiona _Eon‘t ac‘tsl
Name Fax 5503307
& David 5503307
& Tessie 0552-5503307
“'; Michael 221511
sl o
[ ok | [ Ccancel

Figure 4-13

4.2.7 Reply FAX

User can reply to the sender directly for the received fax.

Click on the right mouse on the selected fax, choose ‘Reply’ on pull-down
menu, system will pop up a window where user can edit the fax for remark,
seal and signature.

After the above edition, user can reply the modified fax file to sender.

4.2.8 Check Results

Once sent out from Client, the fax task sumbmitted to Server side. If the fax
file is waiting in line for processing or is sending fax, the file will be saved in
the ‘Outbox’.

If fax sent successfully, the file file will forward to the ‘Sent Items’. User can
check the recipients, subject, created time and status in this window.

If user fails to send, the fax file will be saved on ‘Outbox’. System shows the
failure reason on the ‘Statu’ of Client, such as busy, no answer, and dead
number.

If user wants to resend the failure fax, just click on selected file; choose
‘Send’ on menu, submit failure number to server side again.

Status:
Waiting process — file is waiting in line for faxing
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Sending — system is sending fax

Sent successfully - fax is successfully delivered.

Resending- fax is being resend.

Waiting for idle trunk — trunks are busy, system is waiting for an idle
trunk.

Transmission failure, waiting to try again

Have no valid line - User dialed a wrong access number. For example,
the trunk correct access number is ‘9’, but user dialed ‘7’ that led to the
unavailable of valid trunk.

Wrong router, calls can not pass through — Send fax to an invalid
number.

The callee is busy, waiting to try again.

The callee is busy, system will not try again. — The callee is busy,
the retry times has reached the number that configured in server.
Transmission failure, system will not try again. — After the several
retry times that configured for failure fax, system still fails to send out,
so will not try again.

Transmission over time, system will not try again. — After the
several retry times that configured for failure fax, system still fails to
send out, so will not try again.

4.3 Receive Fax

After enabled Client, BizFAX will pop up a prompted interface on the lower
right corner for the newly received fax.
2 BizFAX 3

Tou have a mew fax.

Figure 4-14
Click ‘Check Fax’ to view contents by the fax editor directly. Click ‘Close’ to
close the interface and user can login Client to check.

4.4 Forward Fax to Email (FAX to Mail)

Send incoming fax to email. In order to auto forward all the incoming faxes
to an appointed email addrss, user requires to pre-setup the email server on
BizFAX Server side.

On Client side, user also needs to do the operation: click ‘File’ > ‘Edit
Profile’ = enable ‘Sending incoming fax to the Email’, please see Figure 4-15
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E-Edit vour profile §|

Name |Dav:i.dl |

Mobile |1395IZIDDDIZIIZIT |

E-mail |chaumin86@126. Com |

[+] send incoming fax to thiz E-mail

| ok || cancel |

Figure 4-15

Once user changed the email address on the Client window as above, his email
information on Server side will be updated at the same time.

4.5 Manage Fax

4.5.1 Edit Subject

The role of the subject is same as a label. User can add a subject for both
received and sent faxes in order to manage them easily in future.

When sending a fax, sender can add a subject on ‘Create a new fax’ window,
from which receiver will quick to know the contents.

For received fax, user can click on selected fax and choose ‘Edit Subject’
from pull-down menu.

Edit Subject E'

Subject |FP.1-I TEST| |

| ok || Ccancel |

Figure 4-16

4.5.2 Group Managment

Create a folder will be helpful to manage faxes.

1. New Folder
Choose ‘Inbox’ and click right mouse, select ‘New Folder’ from pull-down
menu.
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Hew folder

Figure 4-17

Create a name for this folder on the following box
Create... §|

Name || |

Figure 4-18
2. Drag fax to folder

Click on the selected fax file and hold down the mouse, drag it into required
folder.

4.5.3 Delete Fax

After clicked ‘Delete’ button, it will prompt a check window ‘Are you sure to
move the fax(s) to deleted items folder’.

1. Click ‘Yes’
The deleted items will be saved on trash folder temporary.
Users can easily to restore the miss deleted file from trash folder to
origital position.
If need to permanently delete the fax, on trash folder, click ‘Delete’ on
selected fax will be OK.

2. Click ‘No’
Will not to delete the fax.

4.5.4 Print Fax

If user wants to print out the fax, only open it and click ‘Print’ button, system

will prompt a window as Figure 4-18.
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Frirter

MName:

Properties. ..

Status:  Feady
Tope: HF Lazerlet 1020
Where:  USBOO

Cormnient; [ Print to file

Frint range Copies

o Al Mumber of copies: m

C Pages fom |t w3

- (Rl ekl 7
ak. | Cancel

Figure 4-19
4.6 Fax Editor

The fax editior co-works with BizFAXClient to view, edit and make remark on
fax file.

Option 1: Double click on a fax file in Client, click ‘Reply’ or ‘Forward’, and
click ‘Edit Fax’ on the pop window to access fax editor.

Option 2: Click ‘Create’, and add the file you want to fax on pop window,
finally click ‘Edit’ to access fax editor.
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4.6.1 Veiw FAX

¢ EEX
@ 4 H
Send Edit Save
o |
Subject |
File 1ist] Previev]

HEBEE& 24 V1 P

Introduction

BizFAX paperless fax system is an intelligent fax server that combines the
traditional fax technology and network technology.

After connected the PSTN telephone line and built up the connetion with the
LAN or internet, by using the BizFAX Client software on their computers,
users can easily to create a safe, efficient and affordable fax system for
enterprise. Moreover, all of these are electronic processing on computer -
without a piece of paper.

Through BizFAX Client software, every user is able to get the auto-receive,
auto-fax and management features. When sending a fax, users only need to
submit file to BizFAX server, and then system will auto fax the files in order.
Back up the faxes automatically and allow users to easily manage them. It's
helpful to improve the progress of company internal approval, add personal
signature, make company seal, and Mail to FAX and FAX to Mail.

The advanced integration of BizFAX with internet, email and SMS help users
to send and receive faxes at any time any where.

Figure 4-20

= @ B B, from left to right: fit width, fit height, fit visible, actual size

¢ & ? : from left to right: Rotate Counterclockwise 90°, Rotate 180°, Rotate

Clockwise 90°

4.6.2 Remark FAX

It helps user to modify the file contents.
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8 inagel. tiff — FaxEditor

File Fage Zoom BRemark Tools Help

Sd9cORARS-2- L L BB BH G2

Introduction

BizFAX paperless fax system is an intelligent fax server that combines the
traditional fax technology and network technology.

After connected the PSTN telephone line and built up the connetion with the
LAN or internet, by using the BizFAX Client software on their computers,
users can easily to create a safe, efficient and afferdable fax systemn for
enterprise. Moreover, all of these are electronic processing on computer
without a piece of paper.

Through BizFAX Client software, every user is able to get the auto-receive,
auto-fax and management features, When sending a fax, users only need to
submit file to BizFAX server, and then system will auto fax the files in order.
Back up the faxes automatically and allow users to easily manage them. It's
helpful to improve the progress of company internal approval, add personal
signature, make company seal, and Mail to FAX and FAX to Mail.

The advanced integration of BizFAX with internet, email and SMS help users
to send and receive faxes at any time any where.

Figure 4-21

“} . Revocation
™, Reimplement
7. Move page
[y : View page
II: Add text

T : Font

Before making remark on fax, click ‘Font’ to change the size, style and font
of characters.

www.yeastar.com Page 26



- - -
§°® Yeastar BizFAX-E100 Client User Manual
Font 2IX
Font style:
|F|egular 0K |
.Y
Viiner Hand ITC ltalic Cancel
B Vineta BT Bold
() Vivaldi Bald Italic 12
€} Vadimir Script 14
()} ‘webdings 16
() wide Latin » 18
Sample
AaBhYyZz
Scripk:
|'western |
Figure 4-22

4.6.3 Seal & Signature

4.6.3.1 Get seal and signature

Step 1: Save a paper with a seal or a signature into computer.

Method 1: Send the paper from physical fax machine to virtual fax extension,
and login this virtual fax extension and download the paper to computer.
Method 2: Scan the paper by a scanner and save it on computer; Click right
mouse on the newly scanned file and choose ‘Print’ to conver it into TIFF format
file by ‘BizFAX’ virtual printer.

The purpose of this step is to convert file into editable TIFF format.

Step 2: Use the FaxEditor to open the saved file.

Click on the saved file, click right mouse and chose ‘Open’ - ‘Program’, and click
‘View’ on pop-up window, select the FaxEditor.exe that under the BizFAXClient
installation path, click ‘Open’ to edit file.
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Open With...

Look jni | () BizFAXClent v @& i@
@Uninstall.exe Chezo3
LoyBizFar.exe  [Di3se
My Recent EEjFaXViEW.EXE [ﬁFaxLang
Documents = FaxEditor.exe
— 201
L_ | FaxFile
Dezktop 202
205
= 5001
;) (5003
Soo0z
My Documents D
5009
[SiLang
g’ ) Faxviewlang
Chzat
tdy Computer
- . i ]
Q File name: |Fa:-:Ed|tu:ur.e:-:e ‘V‘| 1 DOpen J
My Metwork | Files of type: |F'ru:ugrams L‘.’| [ Cancel ]
Figure 4-23

Step 3: On the opened FaxEditor, click ‘Remark’ > ‘Get Stamp’, drag mouse to
choose on stamp or signature, and then release mouse to extract the stamp or
signature image from paper. Enter a name on the pop-up window as Figure 4-23
The stamp and sigunature images will be saved as BMP & TIFF format.

FFED: [@ 5@

x| = E

e
) EAOEE
IFLLm

LS

[EaEE

[ #ze |

{RFEEE () IEMP Files (¢ bmp;#. dib) ; TIFF Files (x ;[ i

||
LSS A |

Figure 4-24
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Step 4: After clicked ‘Save’, the extracted images will be saved into manager as
Figure 4-25

E:Set Stamp Image

port Stamp Delete Stamp Set Fassword Change Fassword OF

Figure 4-25
Step 5: Click ‘OK’ to finish the operation of extracting stamp and signature.

4.6.3.2 Set Stamp Image
There are two methods to set stamp image:

1. Import Stamp

Click ‘Remark’ -> ‘Stamp Image’ -> ‘Set Stamp’; on the prompt ‘Set Stamp
Image’ window -> click ‘Import Stamp’. User can import the BMP and TIF
formart pictures that already saved in computer. The accuracy is better around
100dpi.

2. Signature
Click ‘Remark’ -> ‘Signature Image’ ->'Set Signature’; on the prompt ‘Set
Signuature Image’ window -> click ‘Add Image’.

4.6.3.3 Set Password
Cick ‘Remark’ - ‘Set Stamp’, open the following figure:
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E-Set Stamp Image

Inport Stamp Delete Stamp Set Fassword Change Fassword OF

CompanyStamp

Figure 4-26

The lefe area is the list of all stamps and stamp image shows on the right
area.

For the safety of using stamps, users can set password on the following
window.

S5et Password |E|

Enter password ‘

Enter passarord ‘

OE | Canrel

Figure 4-27

4.6.3.4 Application of Stamp

=3 : Stamp

All the imported stamps will be listed under pull-down menu of = icon,

just select a stamp to seal on fax file.

IR RN Y
v 1 NyStamp
2 Company=tamp

Figure 4-28

If it has password protection, system will prompt the following box, user is
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asked to enter password.

Pazsword Authentication El

Enter passarord:
QK | Cancel |

Figure 4-29

# : Signature

All the added signature images will be listed under pull-down menu of 1}

icon, just select a signature to seal on fax file.

VIMERE A=

v 1 MySignature

Figure 4-30

4.7 Fax Extension Management

Fax extension refers to all users that using fax system. They are able to
check each other’s information (ext. number, email address and mobile
number) and forward faxes and send SMS among extensions.

There are two types of fax extensions: physical fax extension and virtual fax
extension. Physical fax extension means the real fax machine, and virtual
fax ext. stands for the ext. registered by BizFAX Client to manage faxes.

Extension Status:
I
[[F o]

It means the virtual fax extension is offline.
It means the virtual fax extension is available.

Eﬁ It stands for a physical fax machine.
Extensions Group:
Through clicking ‘View’ - ‘Show Extensions Group’ to see all groups of

extensions.
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I8 RBizFAY — 5007

File RERTE Contacts

| # Show dial panel
fefr] v Show extensions group

My f: v Show contacts group

Tool=s Help

A1

Technologzy
SellService
Managelbr oup

Ungr ouped

Hame Ext.no | Mobile E-mail
E:B 604 604
E:g 603 803
@ 602 602
53 601 601
m Holly S0z8 13950000028 ahellyeastar. con
6] Heather 5024 13950000024 abe@yeastar. con
tu’ Hazel 020 13950000020 abeollyeastar. con
m Haylee SO016 13950000016 ahellyeastar. con
I Harva 5012

13950000012 ahelyeastar,
13950000005 abcliyeastar:

All members in this

group

tu’ Harmongy 008
td Gytha 5004 13950000004 abeollyeastar. con
I} Bramwell 5030 13950000030 abeo@yeastar. con
tu’ Eradl ey 026 13950000026 abeollyeastar. con
td Eradford 5022 13950000022 abeollyeastar. con
] Fraden 5018 13950000018 abc@yeastar. con
|
1
:
Figure 4-31

4.8 Contacts Management

After signed in BizFAXClient, you can see Contacts tag. Here, you are possible to
add, edit, delete, rename, send, import and export contacts.

4.8.1 Contacts Group Management

Before editing contact’s profile, you can classify it into group at first, which
will be easier to manage and send fax by group at once.

You can see contacts in group way thorugh ‘View’-> ‘Show Contacts Group’ (see

Figure 4-32)
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8 BizFAX — 5007 (=13
File BESTN Contact=z Tools Help
v Show dial 1
C ow di pane. E] x
Cre ¥ Show extenzions group
VB v Show contacts group
mﬁ.dd group 5 75
Ml Fame Fax Mobile
Client ‘5_ Jessie 0592-5503307 15980222222
Ungrouped "."_ Dawid EE03307 13123455838
& Michael 8221511
ad]
- Ll O |
2\ 458
\ rPoeoe
4@ .o
Figure 4-32

4.8.2 Add New Contact

You can add new contact through Menu—->Add New Contact or click the mouse to
open the adding screen.

Please edit contact’s profile on following screen, such as name, office phone,
and company name and so on.
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8 4dd new contact X
&} Edit wour contact’ = profile
Name David | Memo
Fax 5503307 |
Office Phone 5503302 |
Mobile Phone | |
Group (Client v|
Company Tealink |
Job title sale| | msw | |
E-mail | | Skype | |
Postcode | |
Web page | |
Address | |
[ spply || ok || Cancel |
Figure 4-33

4.8.3 Edit & Delete Contact

Select contact and click on mouse right to choose edit or delete from pop-up
menu.

4.8.4 Send Contact

Contacts information are shareable among extensions. Click on the selected
contact, click on mouse right-> click ‘Send Contact’ on menu - Open the window
as Figure 4-34 to select the extension.

Note: You can select all through Ctrl+A or click on Ctrl or Shift to choose
multiple contacts.
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& Send contacts

v

Jc 5003 [Afton)

M} 5004 (Gytha)

Mo} 5005 (hekley)

)i 5006 (Baoth)
Mo} 5008 (Harmony)
) 5009 tActon)
I} 5010 (Bor den)
Ko 5011 (Ml dercy)

Jc) 5012 (Harwa)
Status

5

Waiting to =zend...

. # Send contacts to selected users

Addx

(<]

H 5001 (Fipige)
ﬁj 5002 (Booker)

0K Cancel

J |

Figu

4.8.5 Import Contact

re 4-34

User can import contacts in quantity from menu ‘Contacts’--> ‘Import Contact’.

Step:
1. Select the file (.csv) you want to import and click ‘Open’button (figure
4-35)
open 0 21 x|
Lock in: | 9 6008 =lo* e mE

File name:

|D:untau:ts.c:sv

Open |

Files of type: I[“.csv]

[~ Open as (ead-only

ﬂ Cancel |

A

Figure 4-35

2. Double click the item to select corresponding address, see Figure 4-36
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ﬁ,lap the fields you wish to import
Text fields Lddrezz book fields
Hame "
office
Mobile
Home Office Phone
Title Mobile Phone
Company Home Phone
Fax Job Title
M5N Company
Skype Fax
FPostcode MSN
bddrezs Skype
Email Postcode
Web Address

Email
a Double click item to =zelel¥Web

Memo

Speed dial

Target Number

Figure 4-36

3. Click ‘OK’ to finish this step.

4.8.6 Export Contacts

You can export contacts to save up on computer as well.

Step:

1. Select the routing that you want to save, and then click ‘Save’ to finish as

Figure 4-37

saveas 0 NN 21|

Save in | 3 6008 o2 -
T

File name: |Eontacts Save I
Save ag type: I["_c:sv] j Cancel |
4

Figure 4-37
2. Enter the file name and click ‘Save’ button to export contacts into csv file.
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4.9 Internal Communications among extensions

For the convenience of communications among extensions,

BizFAX

embedded an instant talk system allow users to get voice calls or text chat

with other members.

4.9.1 Voice Talk

There are three ways to make a call between extensions:

1) Double click on the extension number that you want to call
2) Enter the ext.number directly on the box and click ‘Call’ button
3) Dial the ext. number on the small keyboard and click ‘Call’ or ‘Enter’

button.

B BizFAX - 5007 (=13

File Viex Contacts Tools Help

4.9.2 Text Chat

o~ e ~ ’
= @ 2 ~<
Create
My fax | Contacts | Fax extensions N Y\
A1 Hame Ex... ' Mobile e ~
Technology £ o L
SellZervice @ 603 £02
Meanazetroup 53 802 £02
Ungrouped @' g01 £01
& Bramwell 5030 13950000030 abclyeasztar. com
o Aleett S029 13950000029 abelyeastar. com
I Helly 5023 13950000028  abe@yeastar. com
o Audrey S0zT 13950000027 abolyeastar. com
& Bradley S026 13950000026 abclyeasztar. com
I tg Al and S025 13950000025 abelyeastar. com
‘ ‘ I} Heather S024 13950000024 abc@yeastar. com
| Mg Ashlew 5023 13950000023 abolyeastar. com
o Bradfoerd 5022 13950000022 abclyeasztar. com
o Ailen 021 13950000021 abelyeastar. com T
| I Hazel S020 13950000020  abe@yeastar. com 3 g%%
|| | S
ESlbEs
sile
wow || £ —§-
Figure 4-38

BizFAXClient provides the internal instant message system for users to chat
easily with other members on extensions listing.
On extensions list, select the member you want to chat with, click ‘Start Chat’
button or click mouse right to open the chat screen.
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#* Az=cialG008) |Z”E”gl

?'." hzzcialB008) iz online.
2 Emotions = GStart call /_'_'_':Send email x| Chat history
Michael (2008-10-15 11:37:56): ~

hellal =
Azzcial2008-10-15 11:38:06):

Hi

o
Figure 4-39

4.10 Personal Profile

For the convenience communication with your colleagues and friends,
BizFAXClient provides personal information management, so that you can
update profile at any time.

After signed on BizFAXClient, click ‘File’ -> ‘Edit profile’ to open personal
information screen.

B Eait vyour profile E'

Name |David |

Mobile |1395IZIIZIIZIEIIZIIZIT |

E-mail | chaomin&a@l 26, com |

[¥] 5end incoming fax to thisz E-mail

| ok || cancel |

Figure 4-40

Here you are allowed to change name, mobile phone number and Email
address.

When receive a fax, auto forward to this email: After received a fax,
system will auto transfer it to the pre-arranged Email addess.
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4.11 Change Password

User can change password through ‘File’> ‘Change Password’ setting, open the
chat box as Figure 4-42 to change password.

ﬂ- Change password §|

01d paszsword
R A
New paszszword

Aok ok

Repeat new paszsword

AR A

0K || Cancel

Figure 4-41

4.12 Change Language

BizFAXClient has multiple language versions. You can change the Client
language through ‘Tools’ > ‘Change Language’.

4.13 Audio Settings

You can open the screen as Figure 4-42 to set up audio device and adjust audio
volume. Click on menu ‘Tools’ - ‘Options’ - ‘Audio Settings’.
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BizFAE Client — Options

System

Audio settings

Spesker | USE Audio Deviee v|
fat
b
Microphone |USB Audio Device v |
g
{
Cm= [ &8 ] odw

Figure 4-42

4.14 Sign out & Exit

Sign Out:

You can sign out BizFAXClient on menu ‘File’ - ‘Sign Out’

Exit:

You can exit from BizFAXClient on menu ‘File’> ‘Exit’ or you can click on
BizFAX icon on right tray and click ‘Exit’ to exit as Figure 4-43.

Open BEizFAX Client

Exit

Figure 4-43
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Appendix A How to make fax file in TIFF format?

Here, we take use of BizFAX'’s virtual fax printer (BizFAX) to make .TIFF fax file.
Take an example of a Word format file:

Step 1: Open the Word format file, click ‘File’ —*Print’.
Step 2: Select the ‘BizFAX’ on pop-up screen and click ‘OK’, BizFAX will transfer
the word file into TIFF format file.

&eint 2|

General |

— Select Printer

soft Auko Microsoft Auko Microsoft
... ©Office Docu... Office Docu, .

2, o

HP Laserlet Microsol
1020 on CHY  Office Do w

4 I »
Statuz: Ready [~ Frint to file  Preferences |
Location:

Cornrment; Find Printer... |
— Page Range

Lol | MNumber of copies: |1 3:

) Selection € Cument Page

" Pages: I [T | Callate Ijl-
flaf

Frint I Cancel | Apply |

Figure A-1

Step 3: Open the installation routing of BizFAXClient, there is a FaxFile folder,
where is the transferred TIFF files saved.

For example, BizFAXClient was installed on
D: \Program Files\Yeastar\BizFAXClient, as Figure A-2
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Copy this Folder ﬁ ﬁ @ ﬁ ﬁ ﬁ
&8 Publish this Folder to the e ) L B

Weh libkiff. dil SkypeCom.dl  Uninstall.exe  uninstall.ini snc.dll wnk.dll ®5IP.dil
k= share this Folder
(=) E-mail this Folder's files
¥ Delete this folder

Other Places ¥
Details ¥
1 objects selected | d Iy Computer A
Figure A-2
& FauFile _ ol x|
File Edit Yiew Favorites Tools Help | {.’
@Back - O - l.@ ;) Search i Folders v
Address IB C:\Program Files\Yeastar|BizPEXClient|FaxFile j Go
FIEEE - | ol mmEe - | @ | CMEmESS O FEEE @ SEEE - ) b - | 23
File and Folder Tasks &

IEID Rename this file

_&- Move this file

Copy this file

@ Publish this file ta the Web BizFaxFiled kiff
() E-mail this file

q‘g Print this file

¥ Delete this file

"\

Default Fax Path.kxt BizFaxFilel1.kiff

<%

Other Places

<%

Details

Cimensions: 1728 x 2292 Type: Micrasoft Office Document Imaging 3514 Size: 176 KB 176 KB | d Iy Computer A

Figure A-3
<{Finish>
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